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ABSTRAK 

 

REHABILITASI PERENCANAAN IRIGASI PASANG SURUT  

RAWA PITU (WAY PIDADA – WAY TULANG BAWANG) 

STUDI KASUS SALURAN PRIMER 3 

 

Oleh 

ANISA MEIDASARI 

Pengembangan lahan rawa pasang surut mendapatkan perhatian besar karena 

potensinya yang signifikan untuk dikonversi menjadi lahan pertanian. Provinsi 

Lampung menyimpan potensi besar dalam hal pengembangan lahan rawa, termasuk 

Rawa Pitu di Kabupaten Tulang Bawang yang memiliki kesuburan tanah yang 

menjanjikan, sehingga lahannya layak untuk dikelola dan dimanfaatkan guna 

meningkatkan produktivitas pertanian dan mendukung kehidupan masyarakat. 

Tujuan penelitian adalah merencanakan irigasi rawa pasang surut untuk pengairan 

ke pertanian dengan menganalisis pasang tertinggi-surut terendah, modulus 

drainase, dan desain pintu klep yang akan digunakan untuk tiap saluran sekunder.  

Penelitian dilakukan dengan mengidentifikasi masalah yang terjadi seperti sering 

terjadinya gagal panen dan tergenangnya lahan pertanian pada musim penghujan. 

Selanjutnya, dilakukan studi literatur dengan mengumpulkan data primer (kondisi 

eksisting saluran di lapangan) dan data sekunder (curah hujan dan tata guna lahan). 

Hasil perencanaan saluran irigasi disimulasikan melalui software HEC-RAS 6.5. 

Dengan pemodelan software Wxtide didapatkan ketinggian pasang surut pada 

sungai Way Tulang Bawang yaitu sebesar 1,6 meter pada kondisi pasang dan 0,20 

meter pada kondisi surut. Dengan perhitungan curah hujan tiga harian maksimum 

periode ulang 5 tahun didapatkan nilai modulus drainase sebesar 0,0039 m3/s/ha. 
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Sedangkan pola tanam rencana di D.I.R. PITU adalah Padi – Palawija – Palawija. 

Pola tanam itu memiliki potensi yang besar untuk meningkatkan produktivitas 

lahan, pendapatan petani, dan ketahanan pangan. Dengan menerapkan 

rekomendasi, diharapkan pola tanam ini dilaksanakan optimal dan berkelanjutan. 

Kesimpulannya adalah banjir yang melimpas ke permukaan dapat diatasi dengan 

cara mengeruk dasar saluran dan meninggikan puncak dinding tanggul. Debit 

pembuang di lahan harus segera dialiri kembali ke saluran primer melalui saluran 

sekunder dengan pintu klep otomatis sehingga air tidak menggenangi lahan yang 

mengakibatkan kerusakan tanaman hingga terjadinya kegagalan dalam masa panen. 

Kata Kunci : HEC-RAS, Pasang Surut, dan Rawa.  

 

  



ABSTRACT 

REHABILITATION OF TIDAL IRRIGATION PLANNING  

RAWA PITU (WAY PIDADA - WAY TULANG BAWANG) 

CASE STUDY OF PRIMARY CHANNEL 3 

By  

ANISA MEIDASARI 

The development of tidal marshland has received great attention due to its 

significant potential to be converted into agricultural land. Lampung Province holds 

great potential in terms of swamp land development, including Rawa Pitu in Tulang 

Bawang Regency which has promising soil fertility, so the land is worth managing 

and utilizing to increase agricultural productivity and support community life. The 

purpose of the research is to plan tidal swamp irrigation for irrigation to agriculture 

by analyzing the highest-lowest tides, drainage modulus, and valve design to be 

used for each secondary channel.  

The research was conducted by identifying problems that occur such as frequent 

crop failure and flooding of agricultural land during the rainy season. Furthermore, 

a literature study was conducted by collecting primary data (existing conditions of 

the channel in the field) and secondary data (rainfall and land use). The results of 

irrigation channel planning were simulated through HEC-RAS 6.5 software. 

By modeling the Wxtide software, the tidal height of the Way Tulang Bawang river 

is 1.6 meters at high tide and 0.20 meters at low tide. By calculating the maximum 

three-day rainfall for 5-year return period, drainage modulus value is 0.0039 cubic 

meters/second/hectare. 

 

  



Meanwhile, the planned cropping pattern in D.I.R. PITU is Paddy-Palawija- 

Palawija. The cropping pattern has great potential to increase land productivity, 

farmers' income, and food security. By implementing recommendations, it is 

expected that this cropping pattern will be implemented optimally and sustainably. 

The conclusion is that flooding that over flows to the surface can be overcome by 

dredging the channel bottom and raising the top of the embankment wall. The 

discharge in the field must be immediately flowed back into the primary channel 

through the secondary channel with an automatic valve door so that the water does 

not inundate the land which results in crop damage and failure in the harvest period. 

Keywords: HEC-RAS, Tidal, and Swamp.  
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I. PENDAHULUAN 

 

1.1 Latar Belakang Masalah 

Lahan rawa dicirikan oleh topografinya yang relatif datar atau cekung dengan 

kondisi drainase yang buruk. Hal ini menyebabkan terakumulasinya air, 

sehingga lahan rawa tergenang secara alami sepanjang tahun atau minimal 

selama periode tertentu yang cukup panjang (semusim) (Kodoatie et al., 2007; 

Kementerian PU, 2008). Lahan rawa dikategorikan menjadi dua jenis utama 

berdasarkan pengaruh pasang surut air lautnya yaitu rawa pasang surut yang 

merupakan lahan rawa terletak di kawasan pesisir, baik di pantai, dekat pantai, 

maupun di muara sungai, sehingga dipengaruhi oleh fluktuasi pasang surut air 

laut dan rawa non pasang surut merupakan lahan rawa yang tidak terpengaruh 

oleh pasang surut air laut, umumnya terletak di pedalaman atau jauh dari 

kawasan pesisir. 

Pengembangan lahan rawa pasang surut mendapatkan perhatian besar karena 

potensinya yang signifikan untuk dikonversi menjadi lahan pertanian. Lahan-

lahan ini dinilai cocok untuk ditanami berbagai komoditas pangan, seperti padi 

dan palawija, yang dapat mendukung program ketahanan pangan nasional 

(Mulyana, 2012). Indonesia memiliki potensi sekitar 9,5 juta hektar lahan rawa 

pasang surut yang dapat dikembangkan untuk kegiatan pertanian (Noor, 2004).  

Lahan-lahan ini tersebar di tiga pulau utama, yaitu Sumatera dengan luas 

terluas mencapai 3,9 juta hektar, diikuti Papua 2,8 juta hektar, dan Kalimantan 

2,7 juta hektar (Sudana, 2005). Data menunjukkan bahwa sekitar 4,1 juta hektar 

(44%) dari total potensi lahan rawa pasang surut telah dikelola, baik melalui 

program reklamasi pemerintah maupun usaha swadaya masyarakat (Sudana, 
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2005). Hal ini menunjukkan masih terdapat potensi besar untuk pengembangan 

lahan rawa pasang surut di masa depan. 

Provinsi Lampung menyimpan potensi besar dalam hal pengembangan lahan 

rawa, termasuk Rawa Pitu di Kabupaten Tulang Bawang. Terletak di antara 

Sungai Pidada dan Tulang Bawang, kawasan rawa ini memiliki kesuburan 

tanah yang menjanjikan, sehingga menjadikannya lahan yang layak untuk 

dikelola dan dimanfaatkan guna meningkatkan produktivitas pertanian dan 

mendukung kehidupan masyarakat. 

Berdasarkan fenomena dan permasalahan yang terjadi di Kabupaten Tulang 

Bawang tersebut, peneliti menjadi tertarik dan merasa perlu untuk melakukan 

penelitian lebih lanjut mengenai saluran irigasi rawa pasang surut. Dengan 

demikian penelitian ini akan dilakukan dengan judul “Rehabilitasi 

Perencanaan Irigasi Pasang Surut Rawa Pitu (Way Pidada – Way Tulang 

Bawang) Studi Kasus Saluran Primer 3”. Hasil penelitian diharapkan dapat 

berkontribusi kepada Pemda Kabupaten Tulang Bawang dalam rangka 

meningkatkan sistem pertanian, sebagai bentuk kontribusi daerah dalam 

meningkatkan ketahanan pangan di Indonesia. 

 

1.2 Identifikasi Masalah 

 

Rendahnya produktivitas pertanian di Daerah Irigasi Rawa (D.I.R) Tulang 

Bawang dapat dikaitkan dengan beberapa faktor yaitu kualitas air yang tersedia 

belum mencukupi kebutuhan tanaman. Hal ini dapat disebabkan oleh berbagai 

faktor, seperti fluktuasi muka air, sistem irigasi yang tidak optimal, dan 

pencemaran air. Selain itu, aspek operasional dan pemeliharaan infrastruktur 

tata air memiliki pengaruh signifikan terhadap keberhasilan produktivitas 

pertanian. Infrastruktur yang tidak terawat dengan baik dapat menyebabkan 

inefisiensi irigasi dan kebocoran air sehingga dapat merusak tanaman. 

Lahan rawa pasang surut dihadapkan pada permasalahan umum, yaitu 

penggenangan air yang bersumber dari curah hujan tinggi di musim penghujan, 

banjir dari sungai utama, pasang naik air laut serta kombinasi dari ketiga faktor 
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di atas. Sementara itu, pada musim kemarau, terjadi kekeringan. Di daerah 

yang dekat dengan muara, terdapat pula fenomena rob, yaitu masuknya air laut 

ke daratan. 

Daerah Irigasi Rawa (D.I.R) Tulang Bawang mengalami fluktuasi muka air 

yang dipengaruhi oleh pasang surut air laut dan musim hujan. Pada musim 

hujan, pasokan air pasang dan curah hujan yang tinggi menyebabkan kenaikan 

muka air yang cepat. Hal ini mengakibatkan tergenangnya lahan pertanian. 

Kondisi genangan air di lahan pertanian D.I.R Tulang Bawang perlu dikelola 

dengan cermat agar sesuai dengan kebutuhan tanaman. Genangan yang 

berlebihan dapat merusak atau menghambat pertumbuhan tanaman. 

 

Dari latar belakang dan uraian di atas dan dengan memperhatikan fakta di 

lapangan dapat diidentifikasi masalah sebagai berikut:  

1. Tergenangnya lahan pertanian di sekitar Rawa Ragil (Saluran Primer 3) 

pada musim penghujan mengakibatkan lahan pertanian tidak dapat 

dimanfaatkan. 

2. Produktivitas pertanian di daerah rawa pasang surut masih rendah. 

3. Terjadi kenaikan muka air laut (sea level rise). 

4. Kekhawatiran terjadinya gagal panen pada masa tanam terutama musim 

penghujan sehingga dapat menimbulkan kerugian dan menurunnya 

motivasi petani untuk melakukan usaha tani di daerah rawa pasang surut. 

 

1.3 Perumusan Masalah 

 

Permasalahan yang akan dibahas pada tugas akhir ini yaitu: 

1. Berapa besarnya pengaruh modulus drainase pada perencanaan irigasi rawa 

pasang surut daerah Pidada, Tulang Bawang? 

2. Berapa lebar pintu klep yang digunakan untuk tiap saluran sekunder agar 

ketika air pasang, tidak menggenangi lahan pertanian sekitar? 

3. Bagaimana mengembalikan kinerja jaringan irigasi rawa untuk mengatasi 

permasalahan yang terjadi di daerah studi?  
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1.4 Batasan Masalah 

 

Batasan masalah yang diambil dalam analisa tugas akhir ini yaitu: 

1. Kajian terhadap perhitungan curah hujan 3 harian maksimum dilakukan 

dengan periode kala ulang 5 tahun. 

2. Jaringan tata air daerah rawa pasang surut yang ditinjau adalah jaringan 

yang sudah ada di lapangan saat ini. 

3. Kajian terhadap perencanaan saluran irigasi dilakukan sampai tahap saluran 

sekunder. 

 

1.5 Tujuan Penelitian 

 

Adapun tujuan dari penelitian ini yaitu: 

1. Merencanakan irigasi rawa pasang surut untuk pengairan ke pertanian. 

2. Menganalisis pasang tertinggi dan surut terendah untuk tinggi jagaan. 

3. Menentukan besarnya nilai modulus drainase yang akan digunakan dalam 

perencanaan saluran irigasi rawa pasang surut daerah Pidada, Kabupaten 

Tulang Bawang. 

4. Merencanakan desain pintu klep yang digunakan untuk tiap saluran 

sekunder. 

 

1.6 Manfaat Penelitian 

 

Hasil penelitian yang diperoleh dapat memberikan manfaat seperti: 

1. Bagi akademis, penelitian ini bermanfaat sebagai referensi untuk penelitian 

sejenis sehingga dapat lebih memahami bagaimana melakukan analisis dan 

perencanaan terhadap saluran irigasi dan keterkaitan antara ilmu teoritis 

dengan pelaksanaannya di lapangan. 

2. Bagi instansi terkait, penelitian ini bermanfaat sebagai bahan evaluasi atau 

bahan pertimbangan dalam pengambilan kebijakan untuk melakukan 

tindakan terhadap objek penelitian serta di dalam penelitian pelaksanaan 

pekerjaan sejenis lainnya. 
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1.7 Sistematika Penulisan 

 

Sistematika penulisan yang digunakan dalam penelitian ini sebagai berikut: 

BAB I : PENDAHULUAN 

 Bab ini berisikan pembahasan mengenai latar belakang, rumusan masalah, 

batasan masalah, tujuan penelitian, manfaat penelitian, sistematika penulisan. 

BAB II : TINJAUAN PUSTAKA 

Bab ini berisikan pembahasan mengenai landasan teori dalam penelitian. 

 BAB III : METODE PENELITIAN 

Bab ini berisikan pembahasan mengenai metode penelitian yang digunakan 

dalam hal ini mencakup lokasi dan waktu penelitian, analisa kebutuhan data 

penelitian, serta tahap-tahap yang akan dilakukan dalam penelitian. 

 BAB IV : HASIL DAN PEMBAHASAN 

Bab ini berisikan gambaran hasil analisa dan penelitian baik secara kualitatif 

maupun kuantitatif, dan pembahasan hasil penelitian yang telah dilakukan. 

BAB V : KESIMPULAN DAN SARAN 

Bab ini berisikan kesimpulan dan saran terhadap penelitian yang dilakukan. 

Pada kesimpulan dikemukakan rangkuman dari masalah yang terjadi selama 

penelitian. Sedangkan saran berisikan solusi atas permasalahan dan keluhan 

yang terjadi selama penelitian.  
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II. TINJAUAN PUSTAKA 

 

2.1 Rawa  

Rawa sebagai bagian tak terpisahkan dari jaringan sumber daya air, merupakan 

area dengan genangan air yang terjadi secara terus menerus atau musiman. 

Terbentuk secara alamiah, rawa memiliki ciri-ciri khas dalam aspek fisik, 

kimiawi, dan biologis (Rudiansyah et al., 2019). Genangan air di rawa dapat 

berasal dari berbagai sumber seperti air hujan, luapan banjir dari sungai utama, 

pasang naik air laut, dan kombinasi dari ketiga sumber tersebut. 

 

Berdasarkan karakteristik fisik dan proses pembentukannya, lahan rawa dapat 

dikategorikan menjadi dua jenis utama yaitu rawa pasang surut atau rawa 

pantai yang merupakan jenis rawa dipengaruhi oleh pasangnya air laut.  

Pengaruh pasang surut ini menyebabkan naiknya permukaan air sungai dan 

menggenangi lahan-lahan di sekitarnya, bagaikan pembendungan alami. (Noor, 

2004; Kementerian PU, 2008). Sedangkan rawa non pasang surut atau rawa 

lebak merupakan jenis rawa yang tidak terpengaruh oleh pasang surut air laut 

dan terletak di daerah pedalaman. 

 

Penelitian ini berfokus pada daerah rawa pasang surut, dengan meneliti dampak 

dan karakteristik yang disebabkan oleh pasang surut air laut. Selain pengaruh 

pasang surut air laut, genangan air di lahan rawa pasang surut juga dapat 

disebabkan oleh air hujan yang tertahan karena sistem drainase yang tidak 

memadai. Berbeda dengan daerah dataran tinggi, dimana sistem tata air dapat 

diatur dengan mudah menggunakan gaya gravitasi, pengaturan tata air di 

daerah rawa pasang surut sangat bergantung pada fluktuasi tinggi muka air laut. 
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Daerah rawa yang umumnya datar hanya dapat diairi dengan memanfaatkan 

perbedaan tinggi muka air saat pasang dan membuang air (drainase) saat surut. 

Hal ini menjadi tantangan tersendiri dalam pengelolaan air di daerah rawa 

pasang surut. 

 

2.2 Pasang Surut  

 

Pasang surut air laut merupakan salah satu fenomena pergerakan air laut yang 

terjadi secara periodik, di samping gelombang laut dan arus laut. Istilah 

"pasang surut" terdiri dari dua kata, yaitu pasang yang merujuk pada keadaan 

saat permukaan air laut lebih tinggi dari rata-rata, dan surut yang merujuk pada 

keadaan saat permukaan air laut lebih rendah dari rata-rata. Di Indonesia, 

istilah "pasang surut" seringkali disingkat dengan pasut (Ahab, 2017). 

 

Sifat dan kondisi muka air di lahan rawa pasang surut dipengaruhi oleh 

beberapa faktor utama yaitu perilaku pasang surut sungai/laut yang secara 

langsung memengaruhi ketinggian air di lahan rawa pasang surut, topografi 

dimana ketinggian dan kemiringan lahan rawa pasang surut turut memengaruhi 

pola genangan air. (Noor, 2001; Kementerian PU, 2008). Dalam proses 

perencanaan bangunan air di daerah rawa pasang surut, diperlukan informasi 

mengenai elevasi-elevasi penting pasang surut. Untuk mendapatkan informasi 

tersebut, diperlukan data pasang surut yang dikumpulkan selama rentang waktu 

tertentu. Data pasang surut ini kemudian dianalisis dan diperamalkan untuk 

mengetahui elevasi-elevasi penting pasang surut selama periode nodal pasang 

surut. Informasi ini sangat penting untuk menentukan desain bangunan air yang 

tepat agar dapat berfungsi dengan optimal di lingkungan rawa pasang surut. 

 

2.3 Reklamasi Rawa Pasang Surut 

 

Reklamasi rawa adalah upaya pemanfaatan sumber daya air rawa untuk 

meningkatkan fungsi dan manfaat rawa melalui teknologi hidraulik untuk 

keperluan manusia (Departemen PU, 2008b; Noor, 2004). Dalam konteks 
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pengembangan rawa pasang surut, reklamasi dilakukan secara bertahap. Tahap 

pertama dengan membangun saluran terbuka tanpa pintu sehingga muka air 

tidak dapat dikendalikan (drainase terbuka), tahap kedua berupa melengkapi 

saluran sekunder dan tersier dengan bangunan pintu pengatur sehingga muka 

air dapat dikendalikan sebagian, dan tahap ketiga melengkapi prasarana 

jaringan reklamasi rawa sehingga muka air dapat dikendalikan penuh. 

 

Rencana operasi reklamasi rawa pasang surut mencakup dua aspek utama yaitu 

rencana tata tanam dengan menentukan jenis tanaman yang ditanam di lahan 

reklamasi, mempertimbangkan faktor-faktor seperti iklim, tanah, dan 

kebutuhan masyarakat dan rencana pengelolaan air berupa mengatur muka air 

pada sistem saluran jaringan reklamasi dan muka air tanah untuk mencapai 

kondisi optimal bagi pertanian dan kehidupan masyarakat.  

 

Reklamasi lahan rawa bertujuan untuk: 

1. Meningkatkan produktivitas makanan, khususnya beras. Reklamasi lahan 

rawa dapat membuka area baru untuk persawahan dan meningkatkan hasil 

panen padi. 

2. Memperluas area persawahan yang semakin berkurang. Lahan persawahan 

di Indonesia semakin berkurang akibat alih fungsi lahan. Reklamasi lahan 

rawa dapat membantu mengatasi hal ini. 

3. Memberikan lahan pertanian bagi transmigran dan meningkatkan 

pendapatan mereka. Transmigran membutuhkan lahan untuk bertani dan 

meningkatkan taraf hidup mereka. Reklamasi lahan rawa dapat 

menyediakan lahan tersebut. 

4. Meningkatkan pendapatan petani dan mendorong pertumbuhan produktif. 

Reklamasi lahan rawa dapat meningkatkan hasil panen dan pendapatan 

petani, sehingga mendorong pertumbuhan ekonomi di daerah pedesaan. 

5. Mendukung program pertahanan dan keamanan, terutama di wilayah pesisir 

dan perbatasan. 
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2.4 Kendala Pengembangan Irigasi Rawa Pasang Surut 

Kegiatan pengembangan rawa sendiri terdapat hambatan atau kendala dalam 

pelaksanaanya. Ada beberapa aspek yang menghambat pengembangan lahan  

mengenai aspek air yaitu sebagai berikut: 

1. Tata Air  

Di dataran tinggi, sistem tata air mudah diatur dengan memanfaatkan gaya 

gravitasi. Hal ini berbeda dengan daerah rawa, di mana tata airnya sangat 

bergantung pada tinggi muka air pasang surut. Karakteristik datar di daerah 

rawa menjadi kendala utama. Sistem irigasi hanya dapat beroperasi dengan 

memanfaatkan perbedaan tinggi muka air saat pasang dan membuang air 

saat surut. 

2. Banjir  

Lahan rawa, dengan topografinya yang relatif datar dan umumnya berada di 

bawah elevasi muka air sungai, menghadapi tantangan serius dalam 

pengelolaan air berlebih, terutama saat musim hujan. 

3. Kekeringan  

Kekeringan bukan hanya menjadi isu di dataran tinggi, tetapi juga di daerah 

rawa pasang surut, khususnya pada tipe C dan D. Semakin jauh letak lahan 

rawa dari sungai, semakin tinggi kemungkinan mengalami kekeringan. 

Pembuatan saluran drainase tanpa perencanaan matang di lahan rawa dapat 

memicu konsekuensi fatal, yaitu buangan air berlebihan (overdrainase). Hal 

ini berakibat pada penurunan muka air tanah yang tidak terkendali. 

4. pH 

Lahan rawa dihadapkan pada dua tantangan utama yang menghambat 

pengembangannya mulai dari derajat keasaman (pH) air di lahan rawa 

umumnya sangat tinggi, yaitu di bawah 4,5. Kondisi tanah yang sangat asam 

ini menjadi kendala utama untuk budidaya padi, tanaman pangan utama di 

Indonesia serta pada musim kemarau, penduduk di lahan rawa mengalami 

kesulitan air bersih. Hal ini disebabkan oleh keterbatasan air tawar dan 

kualitas air yang tidak layak dikonsumsi akibat keasaman tinggi. 

5. Salinitas  

Lahan rawa tipe A, umumnya terletak di dekat sungai atau laut, memiliki 
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potensi besar untuk budidaya padi. Namun, musim kemarau membawa 

tantangan tersendiri, yaitu intrusi air laut yang mempengaruhi sumber air di 

daerah ini. Pada saat musim kemarau debit dari hulu sungai yang mengairi 

lahan rawa ini menjadi kecil sehingga tidak mampu melawan dorongan 

pasang air laut dan terjadi intrusi. 

 

2.5 Perencanaan Sistem Tata Letak pada Jaringan Irigasi Rawa 

 

Areal-areal pada lahan rawa umumnya terlihat datar, sehingga sangat 

dianjurkan untuk mengikuti pola drainase alami, memanfaatkan area rendah 

untuk membantu mencegah kondisi tersumbat, dan mempertimbangkan faktor-

faktor lain dalam merancang sistem drainase. Setelah tahap pengembangan 

awal, di mana jaringan saluran masih berupa sistem terbuka untuk memfasilitasi 

pematangan tanah dan pembuangan air berlebih, langkah selanjutnya adalah 

meningkatkan sistem pengelolaan air dengan melengkapi jaringan saluran 

dengan bangunan pengatur air. 

 

1. Tata Letak Saluran Primer  

Pada sistem drainase lahan rawa, saluran primer bertugas mengangkut air 

dari sumbernya dan mendistribusikannya ke jaringan sekunder. Saluran ini 

menerima air buangan dari sejumlah saluran sekunder, layaknya anak 

sungai yang mengalir ke sungai utama. Dalam sistem sisir pada lahan rawa, 

terdapat lebih dari satu saluran primer yang mengalirkan air buangan 

langsung ke sungai. Jika memungkinkan, sistem ini dapat dirancang dengan 

memisahkan jaringan saluran suplai dan drainase, sehingga aliran air 

menjadi searah. Sedangkan pada sistem garpu, terdapat tiga saluran 

sekunder yang bersatu dan kemudian mengalirkan air ke saluran primer 

pengumpul yang terhubung langsung ke sungai. Bentuk ideal petak primer 

dalam sistem ini adalah segi empat, karena memudahkan pengaturan tata 

letak dan optimalisasi drainase serta suplai air. 
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2. Tata Letak Saluran Sekunder 

Saluran drainase sekunder merupakan saluran yang bertugas membawa air 

dari saluran tersier. Biasanya, saluran sekunder mengalirkan air ke 

bangunan pengatur air sekunder yang terletak di dekat pertemuannya 

dengan saluran primer. Bangunan ini berfungsi untuk mengontrol aliran air 

dan mencegah genangan. Jika memungkinkan secara topografi, bentuk 

petak sekunder idealnya adalah bujur sangkar atau segi empat. Hal ini 

bertujuan untuk mempermudah pengaturan tata letak dan optimalisasi 

drainase serta suplai air. 

 

2.6 Rencana Tata Guna Lahan 

 

Sebelum memulai desain sistem drainase lahan rawa, diperlukan perencanaan 

tata guna lahan yang matang. Perencanaan ini harus mempertimbangkan jenis 

model lahan pertanian yang akan diterapkan, dengan memperhatikan kebutuhan 

drainase spesifik untuk tanaman padi, palawija, dan tanaman keras. Penting 

untuk memastikan bahwa desain drainase tidak hanya optimal untuk padi, tetapi 

juga mempertimbangkan kebutuhan drainase palawija, terutama di musim 

hujan. Hal ini dapat dicapai dengan mempertimbangkan faktor-faktor seperti 

curah hujan, jenis tanah, dan karakteristik tanaman. 

 

Perencanaan tata letak untuk meningkatkan jaringan drainase lahan rawa yang 

sudah ada umumnya mencakup beberapa aspek penting yaitu perencanaan tata 

guna lahan berupa melakukan penataan ulang tata guna lahan untuk memastikan 

lahan dimanfaatkan secara optimal dengan mempertimbangkan kebutuhan 

drainase dan kondisi lahan, selanjutnya perbaikan pengamanan banjir dengan 

meningkatkan sistem penanggulangan banjir untuk melindungi lahan dari risiko 

genangan dan luapan air. Peningkatan jaringan drainase biasanya tidak 

melibatkan perubahan tata letak lahan pertanian dan rencana pemukiman yang 

sudah ada. Namun, jika terdapat lahan usaha yang tidak sesuai dengan kondisi 

tanah maka perlu dicari lahan baru yang lebih sesuai di area sekitarnya, atau 

bahkan memindahkan seluruh lahan pertanian dan pemukiman ke lokasi lain. 
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2.7 Kriteria Perencanaan Irigasi Pasang Surut 

 

Kriteria perencanaan pada sistem tata air disusun sebagai berikut: 

1. Kriteria Umum 

a. Sistem tata air di lahan rawa dirancang dengan tujuan utama untuk  

meningkatkan fungsi jaringan drainase yang sudah ada, menanggulangi 

permasalahan drainase, meningkatkan kualitas dan kemampuan lahan, 

serta mendukung usaha pertanian.  

b. Sistem tata air di lahan rawa memiliki fungsi utama sebagai berikut 

- Menahan intrusi air pasang dan banjir: Mencegah air laut atau air 

pasang memasuki lahan pertanian, sehingga melindungi tanaman 

dari kerusakan akibat salinitas dan genangan air. 

- Mengalirkan kelebihan genangan air: Membuang air berlebih yang 

menggenang di lahan akibat curah hujan tinggi, mencegah 

genangan yang dapat menghambat pertumbuhan tanaman dan 

merusak akar. 

- Memenuhi kebutuhan air dan mengatur muka air tanah: 

Menyediakan air irigasi untuk tanaman padi sawah dan menjaga 

ketinggian muka air tanah pada tingkat yang optimal untuk 

pertumbuhan tanaman. 

c. Perencanaan tata letak saluran dan komponen sistem tata air, termasuk 

tanggul dan bangunan pengendali, harus dilakukan dengan cermat dan 

teliti. Perencanaan ini harus mengacu pada ketentuan dan persyaratan 

yang berlaku, serta mempertimbangkan kriteria-kriteria penting yang 

telah disebutkan sebelumnya. Hal ini bertujuan untuk memastikan 

bahwa sistem tata air yang direncanakan dapat berfungsi secara optimal 

dan mencapai sasaran yang diinginkan. 

 

2. Kriteria untuk Tanaman Padi Sawah 

a. Penyediaan air yang cukup untuk keperluan tanaman 

Sistem tata air di lahan rawa dirancang untuk menyediakan air irigasi 

yang cukup bagi tanaman padi sawah. Air irigasi ini penting untuk 
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pertumbuhan tanaman dan mencapai hasil panen yang optimal. 

Penurunan muka air tanah yang diizinkan untuk sistem tata air ini 

dibatasi hingga 50 cm di bawah permukaan tanah. Hal ini dilakukan 

untuk menjaga ketersediaan air di zona perakaran tanaman, yang 

merupakan bagian penting dari sistem akar tanaman padi sawah. 

b. Pengaturan elevasi muka air tanah 

Sistem tata air yang dilengkapi dengan saluran dan bangunan pintu 

pengendali memungkinkan pengaturan kedalaman muka air tanah 

hingga mencapai elevasi yang diinginkan. Hal ini penting untuk 

menciptakan kondisi tanah yang optimal bagi pertumbuhan tanaman 

padi sawah di lahan rawa. 

c. Pengaliran air genangan yang berlebihan  

Sistem tata air di lahan rawa harus mampu mengalirkan air limpasan 

akibat kelebihan curah hujan yang menggenangi areal persawahan 

dalam waktu 3 x 24 jam melalui saluran drainase. Hal ini penting untuk 

mencegah kerusakan tanaman padi sawah akibat genangan air yang 

berkepanjangan. Tinggi genangan air yang diizinkan di lahan 

persawahan bervariasi tergantung pada tahap pertumbuhan tanaman 

padi. Pada masa tumbuh, genangan air maksimal yang diizinkan adalah 

20 cm. Sedangkan pada saat proses pematangan, genangan air maksimal 

yang diizinkan adalah 5 cm. 

d. Pengeringan pada proses pematangan hingga panen.  

Pada masa pematangan hingga panen padi, kondisi lahan sawah harus 

dijaga agar tetap kering. Untuk mencapai kondisi ini, sistem tata air di 

lahan rawa perlu dirancang dan dioperasikan dengan baik agar 

penurunan muka air tanah dapat mencapai 50 cm di bawah permukaan 

tanah rata-rata. 

 

3. Kriteria Perencanaan Dimensi Saluran 

a. Pengaliran air genangan yang berlebihan 

Sistem tata air di lahan rawa dirancang dengan dua jenis saluran, yaitu 

saluran sekunder dan saluran primer. Saluran-saluran ini berfungsi 
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untuk mengalirkan kelebihan air, baik air limpasan permukaan akibat 

curah hujan yang tinggi maupun air pasang yang meluap ke lahan 

persawahan. 

b. Curah hujan 

Data curah hujan yang digunakan untuk merancang sistem saluran 

drainase di lahan rawa didasarkan pada analisis curah hujan maksimum 

selama 1, 2, 3, 4, 5, atau 6 hari berturut-turut dengan periode ulang 2, 5, 

10, 20, 50, dan 100 tahun. Modulus drainase: 

- Modulus drainase digunakan sebagai parameter penting dalam 

menentukan dimensi saluran drainase yang tepat untuk melayani 

lahan tanaman padi. Modulus drainase ini dihitung berdasarkan 

analisis curah hujan maksimum selama 1, 2, 3, 4, 5, atau 6 hari 

berturut-turut dengan periode ulang 2, 5, 10, 20, 50, dan 100 tahun. 

Tujuannya adalah untuk memastikan bahwa sistem drainase mampu 

mengalirkan kelebihan air dari lahan sawah dalam waktu 3 hari. 

c. Pengaturan elevasi muka air tanah 

- Saluran drainase di lahan sawah bukan hanya berfungsi untuk 

mengalirkan kelebihan air hujan, tetapi juga dapat dimanfaatkan 

sebagai tampungan air untuk menjaga tinggi muka air tanah yang 

optimal bagi tanaman padi pada musim kemarau. Hal ini dapat 

dicapai dengan memanfaatkan potensi pasang surut air laut dan 

bantuan bangunan pengendali air.  

- Di lahan tanaman padi, saluran drainase yang efektif dapat berfungsi 

untuk menurunkan muka air tanah hingga batas zona perakaran 

tanaman. Kedalaman zona perakaran yang optimal bervariasi 

tergantung pada umur tanaman padi. 

 

2.8 Analisis Hidrologi 

 

Analisis hidrologi adalah salah satu bagian dari tahapan perencanaan bangunan 

air, seperti bendungan, bangunan pengendali banjir, dan bangunan irigasi, tetapi 

juga bangunan bangunan jalan raya, lapangan terbang, dan bangunan lainnya 
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(Saily & Jusi, 2022). Ukuran dan jenis bangunan air sangat bergantung dari 

informasi yang didapat dari analisis hidrologi sebelum dilakukannya 

pembangunan. Oleh karena itu, analisis hidrologi sangat penting untuk 

menentukan karakteristik Daerah Aliran Sungai (DAS). Berikut ini adalah 

beberapa komponen hidrologi yang dibahas: 

 

2.8.1 Delineasi Daerah Aliran Sungai dan Karakteristik DAS 

 

Delineasi Daerah Aliran Sungai (DAS) merupakan proses ilmiah untuk 

mengidentifikasi dan mendefinisikan batas-batas wilayah yang 

berkontribusi dalam mengalirkan curah hujan (input) menjadi aliran 

permukaan menuju satu titik luaran (outlet). Proses delineasi ini diawali 

dengan pengolahan data mentah Digital Elevation Model Nasional 

(DEMNAS), sebuah dataset topografi yang digunakan untuk 

menghasilkan gambaran DAS. 

 

Pemetaan DAS dilakukan dengan menggunakan aplikasi GIS 

(Geographic Information System) seperti Global Mapper. Alat ini 

memungkinkan analisis karakteristik DAS secara menyeluruh, termasuk 

luas wilayah, panjang sungai utama, dan kemiringan lereng.  

 

2.8.2 Curah Hujan Rata-rata 

 

Analisis debit banjir merupakan langkah penting dalam memahami 

potensi bahaya dan merancang infrastruktur yang tahan terhadap luapan 

air. Beberapa metode, termasuk metode aritmatik, metode poligon 

Thiessen, dan metode isohyet digunakan untuk menghitung curah hujan 

(Fitriyanti, 2019).  

 

1. Metode Aritmatika 

Metode aritmetik merupakan pendekatan paling sederhana di antara 

metode perhitungan curah hujan rata-rata di suatu kawasan. 
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Penggunaan stasiun dalam penelitian ini harus pada suatu DAS, 

ataupun stasiun yang berada dekat dengan suatu DAS juga bisa 

diperhitungkan. 

 

P̅  = 
𝑃1 + 𝑃2  +…+ 𝑃𝑛

n
  .......................................................................... (1) 

Dimana: 

P̅   = Hujan rata-rata (mm) 

P1, P2,…,Pn = Curah hujan pada stastiun 1,2,…,n (mm) 

n  = Jumlah stasiun 

 

2. Metode Poligon Thiessen 

Metode ini dikenal sebagai metode rata-rata tengah, dimana 

melibatkan pembentukan dari daerah pengaruh untuk setiap 

stasiunnya menggunakan garis-garis sumbu tegak lurus yang 

bersinggungan dan menghubungkan dua stasiun. Metode Poligon 

Thiessen merupakan teknik ilmiah yang digunakan untuk 

menghitung curah hujan rata-rata di suatu kawasan, khususnya 

Daerah Aliran Sungai (DAS). Kelebihan utama metode ini terletak 

pada kemampuannya untuk mempertimbangkan luas wilayah yang 

diwakili oleh setiap stasiun pengukur hujan, sehingga menghasilkan 

perkiraan curah hujan rata-rata yang lebih presisi dan akurat. 

Hujan rata-rata dapat dihitung dengan persamaan berikut: 

 

P̅  = 
𝐴1𝑃1+𝐴2𝑃2+⋯+𝐴𝑛𝑃𝑛

𝐴1+ 𝐴2+⋯+ 𝐴𝑛
  ................................................................. (2) 

Dimana: 

P̅    = Hujan rata-rata (mm) 

P1, P2,…,Pn  = Curah hujan pada stastiun 1,2,…,n (mm) 

A1, A2,…,An  = Luas daerah pengaruh stasiun hujan (km2) 
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Gambar 1. Metode poligon thiessen. 

 

3. Metode Isohyet 

Metode isohyet merupakan teknik ilmiah yang digunakan untuk 

memetakan dan mengukur sebaran spasial curah hujan di suatu 

wilayah geografis. Metode ini memanfaatkan garis-garis isohyet, 

yaitu garis-garis yang menghubungkan titik-titik dengan nilai curah 

hujan yang sama. Ini dapat dilakukan menggunakan rumus berikut: 

 

P̅  = 
𝐴1(

𝑃1+𝑃2
2

)+𝐴2(
𝑃2+𝑃3

2
)+⋯+𝐴𝑛−1(

𝑃𝑛−1+𝑃𝑛
2

)

𝐴1+ 𝐴2+⋯+ 𝐴𝑛−1
  ................................... (3) 

Dimana: 

P̅    = Hujan rata-rata (mm) 

P1, P2,…,Pn  = Garis isohyet ke 1,2,…,n (mm) 

A1, A2,…,An  = Luas daerah yang dibatasi garis isohyet (km2) 

 

 

Gambar 2. Metode isohyet. 
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2.8.3 Parameter Statistik 

 

Proses penelitian distribusi ini merupakan langkah kritis dalam analisis 

hidrologi, karena pemilihan distribusi yang tepat dapat meningkatkan 

akurasi dan ketepatan hasil perhitungan distribusi probabilitas. Dari ke 

4 metode yang ada, dikelompokkan menjadi 2 distribusi, yakni 

Distribusi Non-Logaritmik dan Logaritmik. 

1. Distribusi Non-Logaritmik 

Metode Normal dan Gumbel termasuk Distribusi Non-Logaritmik. 

a. Nilai Rata-Rata (Mean) 

X̅  = 
∑ X

n
  ................................................................................... (4) 

Dimana: 

X̅  = Nilai rata-rata curah hujan (mm) 

X = Nilai curah hujan (mm) 

n = Jumlah data curah hujan 

 

b. Simpangan Baku (Standard Deviation)     

 S = √
∑(X−X̅)2

n−1
  .......................................................................... (5) 

Dimana: 

S = Standar deviasi curah hujan 

X̅  = Nilai rata-rata curah hujan (mm) 

X = Nilai curah hujan (mm) 

n = Jumlah data curah hujan 

c. Koefisien Variasi (Coefficien of Variation)   

Cv = 
S

X̅
   .................................................................................... (6) 

Dimana: 

Cv = Koefisien variasi curah hujan 

S = Standar deviasi curah hujan 

X̅  = Nilai rata-rata curah hujan (mm) 
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d. Koefisien Skewness (Coefficien of Sweekness) 

Cs = 
∑(𝑋−𝑋̅)3

(n−1)×(n−2)×𝑆3   ............................................................... (7) 

Dimana: 

Cs = Koefisien kemencengan curah hujan 

S = Standar deviasi curah hujan 

X̅  = Nilai rata-rata curah hujan (mm) 

X = Nilai curah hujan (mm) 

n = Jumlah data curah hujan 

 

e. Koefisien Ketajaman (Coefficien of Kurtosis) 

Ck = [
𝑛×(𝑛+1)×∑(𝑋−𝑋̅)4

(n−1)×(n−2)×(n−3)×𝑆4
] −

3×(𝑛−1)2

(n−2)×(n−3)
   ........................... (8) 

Dimana: 

Ck = Koefisien kurtosis curah hujan 

S = Standar deviasi curah hujan 

X̅  = Nilai rata-rata curah hujan (mm) 

X = Nilai curah hujan (mm) 

n = Jumlah data curah hujan 

 

2. Distribusi Logaritmik 

Metode yang termasuk dalam distribusi Logaritmik adalah metode 

log normal dan juga metode log pearson tipe III. 

a. Nilai Rata-Rata (Mean) 

LogX̅̅ ̅̅ ̅̅ ̅= 
∑ Log (X)

n
    ..................................................................... (9) 

 

b. Simpangan Baku (Standard Deviation) 

SLogX̅̅ ̅̅ ̅̅ ̅= √
∑ Log (X−X̅)2

n−1
    ......................................................... (10) 

 

c. Koefisien Variansi (Coefficien of Variation) 

Cv= 
SLogX̅̅ ̅̅ ̅̅ ̅

LogX̅̅ ̅̅ ̅̅ ̅      .......................................................................... (11) 
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d. Koefisien Skewness (Coefficien of Sweekness) 

Cs= 
∑ Log (𝑋−𝑋̅)3

(n−1)×(n−2)×𝑆3     ............................................................ (12) 

 

e. Koefisien Ketajaman (Coefficien of Kurtosis) 

Ck= [
𝑛×(𝑛+1)×∑ Log (𝑋−𝑋̅)4

(n−1)×(n−2)×(n−3)×𝑆4
] −

3×(𝑛−1)2

(n−2)×(n−3)
     ........................ (13) 

 

Sifat khas masing-masing parameter statistik dapat ditinjau dari 

besarnya nilai koefisien kemencengan (Cs) dan koefisien ketajaman 

(Ck) yang sesuai dengan syarat dari masing-masing jenis distribusi 

yang dijelaskan pada tabel berikut: 

 

Tabel 1. Parameter Statistik Untuk Menentukan Jenis Distribusi 

No Distribusi Persyaratan 

1 Normal 
Cs = 0 

Ck = 3 

2 Log Normal 
Cs = Cv3 

Ck = Cv8 + 6Cv6 + 15Cv4 + 16Cv2 + 3 

3 Gumbel 
Cs = 1,14 

Ck = 5,4 

4 Log Pearson Type III Selain nilai di atas 

 (Sumber: Triatmodjo, 2008) 

 

2.8.4 Analisa Frekuensi dan Probabilitas 

Analisis frekuensi bertujuan untuk mengetahui besarnya suatu kejadian 

dan frekuensi atau periode ulang kejadian tersebut dengan 

menggunakan distribusi probabilitas (Talumepa, Tanudjaja, & 

Sumarauw, 2017). Berikut metode distribusi yang dapat dilakukan: 

1. Metode Distribusi Normal 

Metode ini disebut juga distribusi Gauss. Perhitungan ini 

menggunakan persamaan: 

𝑋 = 𝑋̅ + 𝐾𝑡 × 𝑆  ......................................................................... (14) 
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𝐾𝑡 =
(𝑋𝑡−𝑋̅)

𝑆
  ................................................................................ (15) 

Dimana: 

XT = Perkiraan nilai yang diharapkan terjadi dengan periode  

   ulang T-tahunan  

𝑋̅ = Curah hujan rata-rata maksimum (mm/hari)  

S = Standar deviasi 

Kt = Faktor frekuensi, merupakan fungsi dari peluang atau  

periode ulang tipe model matematik distribusi peluang 

yang digunakan untuk analisis peluang. 

 

2. Metode Distribusi Gumbel 

XT = X̅ + k × S  ........................................................................... (16) 

k =
(YT−Yn)

Sn
  ................................................................................. (17) 

Keterangan: 

XT = curah hujan rencana maksimum (mm/hari) dengan  

    periode ulang hujan tertentu  

X̅ = curah hujan rata-rata maksimum (mm/hari)  

k  = faktor frekuensi gumbell  

YT  = reduce variate  

Yn  = reduce mean  

Sn  = reduce standard deviation 

 

Tabel 2. Nilai Reduced Variate (YT) 

Periode Ulang 

(tahun) 

Reduced 

Variate 

2 0,3668 

5 1,5004 

10 2,251 

20 2,9709 

25 3,1993 

50 3,9028 

100 4,6012 

(Sumber: Suripin, 2004) 
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Tabel 3. Nilai Reduce Mean (Yn) 

 
(Sumber: Suripin, 2004) 

Tabel 4. Nilai Reduce Standard Deviation (Sn) 

 
(Sumber: Suripin, 2004) 

3. Metode Distribusi Log Normal 

Log(X) = Log X̅̅ ̅̅ ̅̅ ̅ + Kt × SLog X̅̅ ̅̅ ̅̅ ̅  ................................................ (18) 

Kt =
(Xt−X̅)

S
  ................................................................................. (19) 

Dimana: 

Log (X) = logaritmik curah hujan untuk periode tertentu 

Log X̅̅ ̅̅ ̅̅ ̅  = hujan rata-rata dari logaritmik data 

SLog X̅̅ ̅̅ ̅̅ ̅  = standar deviasi logaritmik 

Kt  = faktor frekuensi, merupakan fungsi dari peluang  

atau periode ulang tipe model matematik distribusi 

peluang yang digunakan untuk analisis peluang. 

 

n 0 1 2 3 4 5 6 7 8 9

10 0,4952 0,4996 0,5035 0,5070 0,5100 0,5128 0,5157 0,5181 0,5202 0,5220

20 0,5236 0,5252 0,5268 0,5283 0,5296 0,5309 0,5320 0,5332 0,5343 0,5353

30 0,5362 0,5371 0,5380 0,5388 0,5396 0,5403 0,5410 0,5418 0,5424 0,5430

40 0,5463 0,5442 0,5448 0,5453 0,5458 0,5463 0,5468 0,5473 0,5477 0,5481

50 0,5485 0,5489 0,5493 0,5497 0,5501 0,5504 0,5508 0,5511 0,5515 0,5518

60 0,5521 0,5524 0,5527 0,5530 0,5533 0,5535 0,5538 0,5540 0,5543 0,5545

70 0,5548  0,5550 0,5552 0,5555 0,5557 0,5559 0,5561 0,5563 0,5565 0,5567

80 0,5569 0,5570 0,5572 0,5574 0,5576 0,5578 0,5580 0,5581 0,5583 0,5585

90 0,5586 0,5587 0,5589 0,5591 0,5592 0,5593 0,5595 0,5596 0,5598 0,5599

100 0,5600 0,5602 0,5603 0,5604 0,5606 0,5607 0,5608 0,5608 0,5610 0,5611

n 0 1 2 3 4 5 6 7 8 9

10 0,9496 0,9676 0,9833 0,9971 1,0095 1,0206 1,0316 1,0411 1,0493 1,0565

20 1,0628 1,0696 1,0754 1,0811 1,0864 1,0915 1,0961 1,1004 1,1047 1,1080

30 1,1124 1,1159 1,1193 1,1226 1,1255 1,1285 1,1313 1,1339 1,1363 1,1388

40 1,1413 1,1436 1,1458 1,1480 1,1499 1,1519 1,1538 1,1557 1,1574 1,1590

50 1,1607 1,1623 1,1638 1,1658 1,1667 1,1681 1,1696 1,1708 1,1721 1,1734

60 1,1747 1,1759 1,1770 1,1782 1,1793 1,1803 1,1814 1,1824 1,1834 1,1844

70 1,1854 1,1863 1,1873 1,1881 1,1890 1,1898 1,1906 1,1915 1,1923 1,1930

80 1,1938 1,1945 1,1953 1,1959 1,1967 1,1973 1,1980 1,1987 1,1994 1,2001

90 1,2007 1,2013 1,2020 1,2026 1,2032 1,2038 1,2044 1,2044 1,2055 1,2060

100 1,2065 1,2069 1,2073 1,2077 1,2077 1,2084 1,2087 1,2087 1,2093 1,2096
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4. Metode Distribusi Log Pearson Tipe III 

Log(X) = Log X̅̅ ̅̅ ̅̅ ̅ + K × SLog X̅̅ ̅̅ ̅̅ ̅  .................................................. (20) 

Dimana: 

Log (X) = logaritmik curah hujan untuk periode tertentu 

Log X̅̅ ̅̅ ̅̅ ̅  = hujan rata-rata dari logaritmik data 

SLog X̅̅ ̅̅ ̅̅ ̅  = standar deviasi logaritmik 

K  = faktor dari distribusi Log Pearson Tipe III, dari  

    tabel fungsi Cs dan probabilitas kejadian. 

 

Tabel 5. Nilai k Distibusi Log Pearson Tipe III 

Koefisien 

Kemencengan 

(Cs) 

Periode Ulang (tahun) 

2 5 10 50 100 200 

Peluang (%) 

50 20 10 2 1 0.5 

3.0 -0.396 0.420 1.180 3.152 4.051 4.970 

2.5 -0.360 0.518 1.250 3.048 3.845 4.652 

2.2 -0.330 0.574 1.284 2.970 3.705 4.444 

2.0 -0.307 0.609 1.302 2.912 3.605 4.298 

1.8 -0.282 0.643 1.318 2.848 3.499 4.147 

1.6 -0.254 0.675 1.329 2.780 3.388 3.990 

1.4 -0.225 0.705 1.337 2.706 3.271 3.828 

1.2 -0.195 0.732 1.340 2.626 3.149 3.661 

1.0 -0.164 0.758 1.340 2.542 3.022 3.489 

0.9 -0.148 0.769 1.339 2.498 2.957 3.401 

0.8 -0.132 0.780 1.336 2.453 2.891 3.312 

0.7 -0.116 0.790 1.333 2.407 2.824 3.223 

0.6 -0.099 0.800 1.328 2.359 2.755 3.132 

0.5 -0.083 0.808 1.323 2.311 2.686 3.041 

0.4 -0.066 0.816 1.317 2.261 2.615 2.949 

0.3 -0.050 0.824 1.309 2.211 2.544 2.856 

0.2 -0.033 0.830 1.301 2.159 2.472 2.763 

0.1 -0.017 0.836 1.292 2.107 2.400 2.670 

0.0 0.000 0.842 1.282 2.054 2.326 2.576 

-0.1 0.017 0.836 1.270 2.000 2.252 2.482 

-0.2 0.033 0.850 1.258 1.945 2.178 2.388 

-0.3 0.050 0.853 1.245 1.890 2.104 2.294 
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Tabel 5. Lanjutan 

Koefisien 

Kemencengan 

(Cs) 

Periode Ulang (tahun) 

2 5 10 50 100 200 

Peluang (%) 

50 20 10 2 1 0.5 

-0.4 0.066 0.855 1.231 1.834 2.029 2.201 

-0.5 0.083 0.856 1.216 1.777 1.955 2.108 

-0.6 0.099 0.857 1.200 1.720 1.880 2.016 

-0.7 0.116 0.857 1.183 1.663 1.806 1.926 

-0.8 0.132 0.856 1.166 1.606 1.733 1.837 

-0.9 0.148 0.854 1.147 1.549 1.660 1.749 

-1.0 0.164 0.852 1.128 1.492 1.588 1.664 

-1.2 0.195 0.844 1.086 1.379 1.449 1.501 

-1.4 0.225 0.832 1.041 1.270 1.318 1.351 

-1.6 0.254 0.817 0.994 1.166 1.197 1.216 

-1.8 0.282 0.799 0.945 1.069 1.087 1.097 

-2.0 0.307 0.777 0.895 0.980 0.990 0.995 

-2.2 0.330 0.752 0.844 0.900 0.905 0.907 

-2.5 0.360 0.711 0.771 0.798 0.799 0.800 

-3.0 0.396 0.636 0.660 0.666 0.667 0.667 

(Sumber: Suripin, 2004) 

2.8.5 Pengujan Distribusi Frekuensi 

 

1. Uji Chi – Kuadrat  

Nilai X2 yang digunakan dalam pengujian ini, dapat dihitung dengan 

persamaan berikut: 

DK = K – (P + 1) 

K  = 1 + 3,3 log n 

Keterangan: 

X2  = Nilai Chi-Kuadrat terhitung 

Ef  = Frekuensi yang diharapkan sesuai dengan pembagian kelas 

Of  = Frekuensi yang terbaca pada kelas yang sama 

n  = Jumlah data 

DK  = Derajat kebebasan 
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K  = Banyak kelas 

P  = Banyaknya keterikatan, untuk uji Chi-Kuadrat adalah 1 

 

Tabel 6. Nilai Xcr2 

Dk 
Taraf Signifikansi (α) 

0,5 0,2 0,1 0,05 0,01 

1 0,455 1,642 2,706 3,841 6,635 

2 1,386 3,219 4,605 5,991 9,210 

3 2,366 4,642 6,251 7,815 11,341 

4 3,357 5,989 7,779 9,488 13,277 

5 4,351 7,289 9,236 11,070 15,086 

6 5,348 8,658 10,645 12,592 16,812 

7 6,346 9,803 12,017 14,067 18,475 

8 7,344 11,030 13,362 15,507 20,090 

9 8,343 12,242 14,684 16,910 21,666 

10 9,342 13,442 15,987 18,307 23,209 

11 10,341 14,631 17,275 19,675 24,725 

12 11,340 15,812 18,549 21,026 26,217 

13 12,340 16,983 19,812 22,362 27,688 

14 13,339 18,151 21,064 23,685 29,141 

15 14,339 19,311 22,307 24,996 30,578 

16 15,338 20,465 23,542 26,296 32,000 

17 16,338 21,615 24,769 27,587 33,400 

18 17,338 22,775 25,989 28,869 34,805 

19 18,338 23,900 27,204 30,144 36,191 

20 19,337 25,038 28,412 31,410 37,566 

(Sumber :Triatmodjo, 2008) 

 

2. Uji Smirnov – Kolmogorov  

Dikarenakan pengujian tidak menggunakan fungsi distribusi, maka 

disebut sebagai uji kecocokan non parametrik. Sebaliknya, 

digunakan kurva dan representasi data pada kertas probabilitas. Dari 

gambar dapat diketahui jarak penyimpangan setiap titik data 

terhadap kurva. Jarak penyimpangan terbesar merupakan nilai 

Δmaks dengan kemungkinan didapat nilai yang lebih kecil dari nilai 

Δkritik, maka distribusi yang dipilih dapat digunakan. 
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Tabel 7. Nilai Δkritik  

N 
Level of significance a (%) 

20 15 10 5 1 

1 0,9 0,925 0,95 0,975 0,995 

2 0,684 0,726 0,776 0,842 0,929 

3 0,565 0,597 0,642 0,703 0,829 

4 0,494 0,525 0,564 0,624 0,734 

5 0,446 0,474 0,51 0,563 0,669 

6 0,41 0,436 0,47 0,521 0,618 

7 0,381 0,405 0,438 0,468 0,577 

8 0,358 0,381 0,411 0,457 0,543 

9 0,339 0,36 0,388 0,432 0,514 

10 0,322 0,342 0,368 0,409 0,486 

11 0,307 0,326 0,352 0,391 0,468 

12 0,295 0,313 0,338 0,375 0,45 

13 0,284 0,302 0,325 0,361 0,433 

14 0,274 0,292 0,314 0,349 0,418 

15 0,266 0,283 0,304 0,338 0,404 

(Sumber : Triatmodjo,2008) 

 

2.8.6 Intensitas Curah Hujan Jam-Jaman 

 

Intensitas hujan merupakan parameter penting dalam hidrologi yang 

didefinisikan sebagai jumlah air hujan yang turun dalam persatuan 

waktu atau kedalaman air hujan dalam waktu tertentu (Susilowati & 

Sadad, 2019). Semakin besar intensitas hujan, semakin deras hujan yang 

turun. Faktor-faktor yang mempengaruhi intensitas hujan adalah 

besarnya volume air hujan dan durasi waktu hujan. Hujan dengan 

volume air yang lebih besar dan durasi waktu yang lebih lama umumnya 

memiliki intensitas yang lebih tinggi. 

 

Dalam perhitungan hidrograf banjir, intensitas hujan digunakan sebagai 

salah satu input utama untuk menentukan debit banjir. Hidrograf banjir 

adalah grafik yang menunjukkan hubungan antara waktu dan debit air 

di suatu titik aliran sungai. Persamaan yang umum digunakan untuk 

menghitung hidrograf banjir adalah persamaan metode rasional, yang 

membutuhkan data intensitas hujan dengan selang waktu antara 5-7 jam. 
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IT = T x Rt – [(T – 1) x R(T-1)] 

Rt = (
𝐑24

𝐓
) (

𝐭

𝐓
)2/3

 

Keterangan: 

IT   = Intensitas curah hujan pada jam ke-T 

T   = Durasi hujan dari jam ke-1 sampai jam ke 5-7 

R(T-1)  = Rerata hujan dari awal sampai dengan jam ke (T-1) 

Rt   = Intensitas hujan rerata sampai dengan jam ke-T (mm/jam) 

R24  = Curah hujan maksimum dalam waktu 24 jam (mm) 

t   = Durasi hujan (jam), untuk Indonesia antara 5-7 jam 

 

2.8.7 Hidrograf Satuan Sintetis (HSS) Nakayasu 

 

Hidrograf limpasan langsung atau limpasan permukaan yang dihasilkan 

oleh hujan satuan disebut hidrograf satuan. Di sisi lain, hidrograf 

dimaksudkan sebagai penyajian grafis hubungan antara elemen aliran 

seperti debit (Q) terhadap waktu (t). Berikut merupakan persamaan debit 

puncak banjir dengan metode Nakayasu (Sihotang et al., 2011). 

 

Qp = 
𝟏

𝟑,𝟔
 (

𝐀 .𝐑𝐨

𝟎,𝟑 𝐓𝐩+𝐓𝟎,𝟑
) 

Tp  = tg + 0,8 Tr 

tg  = 0,4 + 0,058 L  (untuk L > 15 km) 

tg  = 0,21 L0,7   (untuk L < 15 km) 

T0,3 = α tg 

tr  = 0,5 tg sampai tg 

Keterangan: 

Qp  = Debit puncak banjir (m3/s) 

A  = Luas DAS (km2) 

L  = Panjang sungai utama (km) 

Ro  = Curah hujan efektif (mm) 

Tp  = Waktu dari permulaan hujan sampai puncak banjir (jam) 

T0,3 = Waktu dari puncak banjir sampai 0,3 kali debit puncak (jam) 
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tg  = Waktu konsentrasi (jam)  

tr  = Satuan waktu curah hujan (jam)  

α  = Koefisien karakteristik DAS, diambil nilai 2 

 

2.9 Modulus Drainase 

 

Modulus drainase merupakan parameter penting dalam perencanaan dan 

desain saluran drainase untuk lahan sawah, tanaman padi, dan area lainnya. 

Modulus drainase didefinisikan sebagai kemampuan saluran drainase untuk 

mengalirkan air dari suatu area dalam waktu tertentu. Semakin tinggi nilai 

modulus drainase, semakin besar kemampuan saluran drainase untuk 

mengalirkan air. Nilai Dm atau modulus drainase adalah jumlah air yang harus 

dibuang dalam satuan lt/s/ha. Dm untuk n hari dapat dihitung dengan 

menggunakan rumus sebagai berikut: 

Dm = 
𝐷𝑛

𝑛𝑥8,64
 

 

Dimana : 

D(n)  =  R(n)T + n(IR - ET - P) - S   

Dm = Drainase Modul (lt/s/ha) 

n  = Jumlah hari berturut-turut 

D(n) = Limpasan air hujan permukaan selama n hari (mm) 

R(n)T  = Curah hujan selama n hari, periode ulang Ttahun (mm) 

IR = Pemberian air irigasi (mm/hari) 

ET = Evapotranspirasi Potensial (mm/hari) 

P  = Perkolasi (mm/hari) 

S  = Tampungan tambahan (mm) 

 

Debit saluran pembuang dapat ditentukan dari rumus sebagai berikut: 

Q  =  1,62 x Dm x A0,92 
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2.10  Pintu Klep 

 

Pada daerah datar dan pantai, saluran drainase sering mengalami permasalahan 

pembuangan air (outlet) karena fluktuasi muka air di badan air penerima. Hal 

ini dapat terjadi pada saluran drainase yang mengalirkan air langsung ke laut 

maupun ke sungai. Saluran drainase yang mengalirkan air langsung ke laut 

terpengaruh oleh pasang surut. Saat air laut pasang, muka airnya lebih tinggi 

daripada saluran drainase, sehingga air tidak dapat mengalir keluar dan bahkan 

terjadi aliran balik (backwater). Sedangkan, saluran drainase yang 

mengalirkan air ke sungai terpengaruh oleh ketinggian air banjir. Saat banjir 

terjadi, muka air sungai lebih tinggi daripada saluran drainase, sehingga air 

tidak dapat mengalir keluar dan kembali tertahan di saluran. Untuk mengatasi 

permasalahan ini, pada pertemuan saluran drainase dengan sungai perlu 

dilengkapi dengan bangunan pengatur berupa pintu pengatur, salah satunya 

adalah pintu klep (pintu otomatis). Pintu klep ini dirancang untuk membuka 

saat muka air di sungai lebih rendah daripada saluran drainase, dan menutup 

saat muka air di sungai lebih tinggi. 

 

Pintu klep (pintu) otomatis pada saluran drainase memiliki fungsi utama untuk 

membatasi masuknya air pasang atau air banjir yang melebihi kapasitas 

saluran. Pintu ini akan terbuka secara otomatis apabila muka air di hilir (bagian 

penerima air) sudah berada di bawah ambang batas kapasitasnya, sehingga air 

di saluran drainase dapat mengalir kembali ke hilir. Mekanisme kerja pintu 

klep otomatis ini didasarkan pada prinsip keseimbangan momen yang 

dihasilkan oleh beberapa komponen, yaitu: 

- Pemberat pintu: Memberikan momen yang cenderung membuka pintu. 

- Pelampung: Memberikan momen yang cenderung membuka atau 

menutup pintu, tergantung pada ketinggian air. 

- Tekanan air: Memberikan momen yang cenderung menutup pintu di hilir 

saat muka air naik (pasang surut atau banjir). 
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Secara lebih rinci, mekanisme kerja pintu klep otomatis dapat dijelaskan 

sebagai berikut: 

a. Pintu klep terbuka: Saat muka air di hulu (bagian atas saluran) lebih tinggi 

daripada di hilir, tekanan air di hulu akan mendorong pintu untuk terbuka. 

Momen dari pemberat pintu juga membantu membuka pintu. 

b. Pintu klep tertutup: Saat muka air di hilir naik (akibat pasang surut atau 

banjir), tekanan air di hilir akan lebih tinggi daripada di hulu. Hal ini 

mendorong pintu untuk menutup melawan momen dari pemberat pintu. 

Pelampung juga dapat membantu menutup pintu saat terendam air. 

 

 



III. METODOLOGI PENELITIAN 

 

3.1 Lokasi Penelitian 

Kabupaten Tulang Bawang terletak pada posisi geografis antara 04° 08' LS - 

04° 41' LS dan 105° 09' BT - 105° 55' BT membentang memanjang Timur ke 

Barat. Secara administratif Kabupaten Tulang Bawang di bagian Utara 

berbatasan dengan Kabupaten Mesuji, bagian Selatan berbatasan dengan 

Kabupaten Lampung Tengah, sebelah Barat berbatasan dengan Kabupaten 

Tulang Bawang Barat, dan bagian Timur berbatasan dengan kawasan pantai 

(Laut Jawa). 

 

Tempat penelitian berada di Desa Rawa Ragil Kecamatan Rawa Pitu Kabupaten 

Tulang Bawang. Lokasi ini diapit oleh Way Tulang Bawang dan Way Pidada 

yang membentang dari barat ke timur. Way Pidada bermuara di Way Tulang 

Bawang yang selanjutnya bermuara di Laut Jawa. Kedua sungai tersebut 

digunakan sebagai sumber air, sarana transportasi bagi masyarakat, dan irigasi 

persawahan. Pengembangan daerah reklamasi rawa D.I. Rawa Pitu diperlukan 

untuk peningkatan kebutuhan pangan masyarakat lokal maupun regional 

dengan memanfaatkan potensi yang ada. Selain itu dengan adanya fasilitas 

pengairan di daerah diharapkan dapat meningkatkan taraf hidup masyarakat di 

sekitar daerah pengembangan melalui usaha bidang pertanian. Berikut 

merupakan peta lokasi kajian yang dapat dilihat pada Gambar 3.  
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Gambar 3. Peta saluran primer 3, Rawa Pitu. 

3.2 Pengumpulan Data 

 

Data yang dibutuhkan antara lain:  

a. Data primer :  

- Kondisi sungai dan keadaan lingkungan lokasi penelitian.  

b. Data sekunder :  

- Data hidrologi didapatkan dari data curah hujan harian sepanjang 1998-

2012 untuk Kawasan Sub DAS Tulang Bawang dari Balai Besar 

Wilayah Sungai (BBWS) Mesuji Sekampung.  

- Data Peta digital tata guna lahan dan Peta topografi DEMNAS (Digital 

Elevation Model Nasional) didapatkan dari Ina Geoportal (Badan 

Informasi Geospasial). Sistem Koordinat menggunakan WGS (World 

Geodetic System) 1984. 
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3.3 Analisis Hidraulika dengan HEC-RAS 

 

Analisis jaringan rawa pasang surut dilakukan dengan membuat model aliran 

air di jaringan tata air di daerah rawa pasang surut Rawa Pitu. Untuk membuat 

model jaringan tata air dengan menggunakan software HEC-RAS dibutuhkan 

peta Digital Terrain Model (DTM) elevasi lahan dengan menggunakan data 

digital elevation model (DEM) yang diperoleh dari data lapangan yang 

digambar dengan perangkat lunak (software) AutoCAD, selanjutnya diubah 

menjadi data DEM dengan menggunakan perangkat lunak Globar Mapper 25.1. 

Data elevasi dalam bentuk DEM ini kemudian diekspor ke Program HEC-RAS 

6.0.5. Dari model ini diperoleh kondisi aliran air di saluran dan kondisi luapan 

air di lahan pertanian.  

 

Pembuatan model aliran di saluran pada lahan rawa yang diteliti dilakukan 

dengan menggunakan software HEC-RAS 6.0.5 dengan input data, seperti 

jaringan tata air daerah rawa yang diteliti, dimensi penampang melintang 

saluran di titik tertentu. Semua informasi tentang jaringan disiapkan dari awal 

penelitian dengan software AutoCAD. Karena sistem yang dikaji adalah sistem 

aliran air adalah unsteady dan ditinjau dalam 2 dimensi, maka elevasi lahan dan 

penampang saluran disiapkan dari awal dalam bentuk peta DTM berupa data 

DEM. Adapun tahap-tahap analisis hidrolika dengan program HEC-RAS 6.5. 

adalah sebagai berikut: 

 

3.3.1 Membuat File Project 

 

Tahapan dalam membuat project baru pada HEC-RAS yaitu: 

 

1. Membuka software HEC-RAS 



34 

 

 

 Gambar 4. User interface HEC-RAS. 

 

2. Memilih menu File > New Project 

 

Gambar 5. Membuat project baru. 

 

3. Menuliskan “Way_Tulang Bawang” pada Project Title dan File 

Name. Setelah itu, mengeklik tombol OK di sisi kiri bawah layer. 

 

Gambar 6. Memberi nama project. 
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4. Memilih menu Option > Unit System (US Customary/System 

International) > System International (Metric System) sebagai 

sistem satuan yang akan digunakan. 

 

Gambar 7. Mengubah sistem satuan HEC-RAS. 

 

 

Gambar 8. Memilih sistem satuan. 

 

3.3.2 Membuat Data Geometri Sungai 

 

Selanjutnya pada proses pemodelan HEC-RAS yaitu dilakukan 

membuat geometri sungai dengan fitur RAS Mapper pada HEC-RAS 

dengan input data terrain yang sudah di clip dari data DEMNAS 

menggunakan software Geographic Information System (GIS). Berikut 

dijelaskan tahapan dalam pemodelan geometri sungai: 

 

1. Memilih menu GIS Tools, kemudian mengeklik menu RAS Mapper.  
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Gambar 9. Membuka menu RAS Mapper. 

 

2. Memilih menu Tools, kemudian mengeklik pada menu Set 

Projection for Project. 

 

Gambar 10. Menu Set Projection. 

 

3. Memasukkan data koordinat wilayah penelitian pada Set Projection 

for Project dengan format .prj. Kemudian mengubah satuan menjadi 

satuan meter pada pemilihan XS River Station. 
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Gambar 11. Memasukkan data projection. 

 

 

Gambar 12. Memasukkan data general. 

 

4. Memasukkan data terrain penelitian dengan cara mengeklik kanan 

pada menu Terrain lalu memilih Create a New Ras Terrain, 

kemudian menginput data terrain dari software SIG. 
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Gambar 13. Membuat file baru terrain. 

 

 

Gambar 14. Memasukkan data terrain. 

 

5. Memilih menu Map Layers, kemudian Memilih Add Web Imagery 

Layer dan Memilih Google Satellite sebagai map layers untuk 

memberi visual peta dan dikombinasikan dengan data terrain. 

 

Gambar 15. Kombinasi terrain dan map layers. 
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6. Selanjutnya mengeklik menu Geometry pada RAS Mapper, lalu 

mengeklik kanan memilih Add New Geometry dan memberi nama 

“waytulangbawang” pada file tersebut. 

 

Gambar 16. Memberi nama pada file geometri. 

 

7. Membuat alur sungai yang akan dikaji sesuai dengan data terrain 

dengan mengeklik menu River > Edit Geometry. 

 

Gambar 17. Membuat alur sungai. 

 

8. Membuat potongan melintang penampang sungai dengan cara 

mengeklik menu Cross Section > Edit Geometry. 
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Gambar 18. Membuat tahapan melintang sungai. 

 

 

Gambar 19. Geometri sungai Way Tulang Bawang. 

 

9. Kembali ke tampilan utama HEC-RAS. Selanjutnya ke menu 

Geometry Data > File > Open Geometry File untuk import file 

geometri yang sudah dibuat di RAS Mapper. Setelah itu mengeklik 

menu Tables > Manning’s n or k Values untuk memasukkan nilai 

koefisien Manning (n) lalu mengeklik set values dan isikan n = 0,025 

untuk seluruh station dan mengeklik OK. 
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Gambar 20. Memasukkan nilai manning (n). 

 

10. Kembali ke tampilan utama Geometric Data, kemudian memilih 

menu Cross Section > Pada menu river, pilih saluran primer > 

Masukkan data station dan elevation saluran sungai yang ingin 

disimulasikan. 

 

3.3.3 Menginput Data Aliran (Unsteady Flow Analysis) 

 

Aliran air yang melewati saluran di daerah rawa pasang surut ini adalah 

aliran tak tetap atau tidak permanen (unsteady flow) karena adanya 

pengaruh gerakan air pasang surut. Untuk merencanakan dimensi 

saluran diasumsikan bahwa pembuangan air dari lahan tersebut akan 

habis selama pasang rendah air surut. 

 

Analisis aliran dalam desain kapasitas saluran, mengingat adanya 

gerakan air pasang-surut, dilakukan dengan memakai konsep aliran 

tidak tetap atau tidak permanen (unsteady flow). Analisis aliran ini 

menggunakan model matematik aliran satu dimensi, dengan program 

software HEC-RAS 6.5. Analisis aliran tidak permanen dilakukan 
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dengan memasukkan data berupa debit rencana dengan kala ulang 5 

tahun dan kondisi pasang surut yang terjadi. 

 

3.3.4 Melakukan Analisis Hidraulika (Running Simulation) 

 

Tahap akhir di dalam pemodelan muka air banjir di saluran ialah 

menjalankan program (running) dengan data-data yang sebelumnya 

telah dimasukkan, berikut merupakan langkah-langkah dalam 

menjalankan simulasi:  

 

1. Pada tahap pertama yaitu mengeklik menu Perform An Unsteady 

Flow Simulation > File > Save Plan kemudian memberi nama “WS” 

dengan “Plan 01” sebagai short ID. Kemudian ceklis semua bagian 

pada programs to run terkecuali sediment, karna pada penelitian ini 

pengaruh sedimen tidak diperhitungkan. Selanjutnya mengeklik 

Compute untuk running analisis. 

 

Gambar 21. Input unsteady flow analysis. 

 

2. Setelah di Compute, maka akan muncul layer hitungan yang 

menunjukkan proses running dan menunggu hingga selesai, 

kemudian mengeklik Close. 
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 Gambar 22. Layar hitungan hidraulika setelah proses running. 
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3.4 Diagram Alir Penelitian 

 

 

 

Gambar 23. Diagram Alir Penelitian. 
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V. KESIMPULAN DAN SARAN 

 

5.1 Kesimpulan 

 

1. Berdasarkan perhitungan curah hujan tiga harian maksimum periode ulang 

5 tahun di dapatkan nilai modulus drainase sebesar 0,0039 m3/s/ha. 

2. Kapasitas rencana debit yang harus dibuang untuk setiap lahannya sebagai 

berikut 0,6828 m3/s, 0,6708 m3/s, 0,5122 m3/s, 0,7893 m3/s, 0,5359 m3/s, 

0,7969 m3/s, 0,5387 m3/s, 0,5149 m3/s, 0,5552 m3/s, 0,9552 m3/s, 0,8038 

m3/s, 0,4799 m3/s, dan 0,3547 m3/s. 

3. Debit pembuang yang ada di lahan harus segera dialiri kembali ke saluran 

primer melalui saluran sekunder. Untuk itu, direncanakan lebar pintu 

otomatis di setiap saluran sekunder dengan nilai masing-masing 1,1712 m, 

1,1506 m, 0,8785 m, 1,3538 m, 0,9192 m, 1,3669 m, 0,9240 m, 0,8832 m, 

0,9524 m, 1,6384 m, 1,3787  m, 0,8232 m, dan 0,6085 m. Pemasangan pintu 

otomatis di setiap saluran diseragamkan dengan ukuran 1,5 m  x 1,5 m. 

4. Berdasarkan kondisi di lapangan menunjukkan bahwa tinggi muka air 

mencapai 1,6 m dan simulasi pada software HEC-RAS menunjukkan tinggi 

muka air yang sama pada saluran primer yaitu mencapai 1,6 m. Hal ini 

menunjukkan bahwa saluran primer tergolong mampu dalam menampung 

debit rencana dengan kala ulang 5 tahun dan pasang surut yang terjadi. 

5. Banjir yang melimpas ke permukaan dapat diatasi dengan cara menggeruk 

dasar saluran dijadikan  serta dengan meninggikan puncak dinding tanggul. 

Saluran yang terpelihara dengan baik juga dapat menjamin air selalu 

tersedia pada saluran karena terdapat cadangan air dari pasang surut laut, 

terlebih jika pintu air beroperasi dengan baik untuk menjaga air tetap berada 

pada saluran.  
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6. Pola tanam yang direncanakan di DIR Pitu adalah Padi-Palawija-Palawija. 

Pola tanam ini memiliki potensi yang besar untuk meningkatkan 

produktivitas lahan, pendapatan petani, dan ketahanan pangan. Dengan 

menerapkan rekomendasi yang diberikan, diharapkan pola tanam ini tidak 

mengalami kegagalan dalam masa panen sehingga dapat dilaksanakan 

secara optimal dan berkelanjutan. 

 

5.2 Saran 

 

1. Diperlukan data keseluruhan saluran dan pengukuran tinggi muka air dari 

DI Rawa Pitu untuk merancang sistem tata air secara keseluruhan. 

2. Kegiatan pemeliharaan berupa normalisasi dan peninggian tanggul penting 

dilakukan secara rutin pada jaringan irigasi rawa agar prasarana pengairan 

ini dapat berfungsi sebagaimana mestinya. 
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